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ibm.com and related resources

Product support and documentation are available from ibm.com.

Support and assistance

Product support is available on the Web. Click Support from the product Web site
at:

FileNet Content Manager Support
http://www.ibm.com/software/data/content-management/filenet-content-
manager/support.html

Information center

You can view the product documentation in an Eclipse-based information center
that you can install when you install the product. By default, the information
center runs in a Web server mode that other Web browsers can access. You can also
run it locally on your workstation. See the information center at
http://pic.dhe.ibm.com/infocenter/p8docs/v5r2m0/index.jsp.

PDF publications

You can view the PDF files online using the Adobe Acrobat Reader for your
operating system. If you do not have the Acrobat Reader installed, you can
download it from the Adobe Web site at http://www.adobe.com.

See the following PDF publications Web sites:

Product Web site

Product Documentation for FileNet
P8 Platform

http://www.ibm.com/support/docview.wss?rs=86
&uid=swg27021508

“How to send your comments”
Your feedback is important in helping to provide the most accurate and highest
quality information.
“Contacting IBM” on page vi
To contact IBM customer service in the United States or Canada, call
1-800-IBM-SERV (1-800-426-7378).

How to send your comments
Your feedback is important in helping to provide the most accurate and highest
quality information.

Send your comments by using the online reader comment form at
https://www14.software.ibm.com/webapp/iwm/web/signup.do?lang=en_US
&source=swg-rcf.
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Consumability survey

You are invited to tell IBM how to improve the consumability of software
products. If you want to help IBM make IBM® FileNet® P8 easier to use, take the
Consumability Survey at http://www.ibm.com/software/data/info/
consumability-survey/.

Contacting IBM
To contact IBM customer service in the United States or Canada, call
1-800-IBM-SERV (1-800-426-7378).

To learn about available service options, call one of the following numbers:
v In the United States: 1-888-426-4343
v In Canada: 1-800-465-9600

For more information about how to contact IBM, see the Contact IBM Web site at
http://www.ibm.com/contact/us/.
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Planning and preparing for installation

This section describes the process for planning for and performing the required
prerequisite tasks for an IBM FileNet Case Analyzer 5.2.0 installation.

Case Analyzer was formerly known as Process Analyzer. Review all of the topics
in the following sections carefully before you begin.

“Planning the installation”
This section lists details that help you prepare your environment for the
installation of IBM FileNet Case Analyzer on an IBM FileNet P8 system.
“Performing required preparation tasks” on page 5
You must complete all of the required preparation tasks before you start the
installation.

Planning the installation
This section lists details that help you prepare your environment for the
installation of IBM FileNet Case Analyzer on an IBM FileNet P8 system.

In many cases, the items are links to more detailed information which help you
plan a system rollout of this expansion product. Review this section thoroughly
before you start to set up associated FileNet P8 components or required vendor
software.

Before you begin to install Case Analyzer, perform the following planning
activities:
v Gather auxiliary documentation. Browse their contents and study those parts

that seem most relevant to your installation and application plans.
v See “Using the installation and upgrade worksheet” on page 3 for more

information about an available Worksheet to record information that is needed
during installation.
“Definition of installation roles”
The tasks in this guide and the rows in the Installation and Upgrade Worksheet
are organized by administrative roles. Your organization might have different
roles, and some of the responsibilities of listed roles will vary from those
assigned by default in this documentation.
“Using the installation and upgrade worksheet” on page 3
The Installation and Upgrade Worksheet is a Microsoft Excel spreadsheet
(p8_worksheet.xls). The worksheet describes the properties and parameters
required to complete IBM FileNet P8 installation, upgrade, and configuration
programs, and provides a way to record the values you assign to these
properties and parameters.

Definition of installation roles
The tasks in this guide and the rows in the Installation and Upgrade Worksheet are
organized by administrative roles. Your organization might have different roles,
and some of the responsibilities of listed roles will vary from those assigned by
default in this documentation.

© Copyright IBM Corp. 2001, 2013 1



Installation administrator
v Runs FileNet P8 installation programs during initial setup.
v Runs Configuration Manager during initial setup, followed by starting IBM

Administration Console for Content Platform Engine.
v Runs FileNet P8 upgrade programs during upgrades.
v Abbreviated as IA. Responsible for coordinating the information described in

this worksheet. The information itself will require the input from the other roles.

The role of IA is usually filled by an IBM FileNet Certified Professional (FCP).

Information technology administrator
v Responsible for the networking and operating systems settings required by

FileNet P8.
v Responsible for performing certain security configurations.
v Abbreviated as ITA. Responsible for providing the information in the rows in

the Installation and Upgrade Worksheet with a value of ITA in the Role column.

Security administrator
v Responsible for configuring the directory servers required by FileNet P8

components, including Content Platform Engine and Application Engine.
v Creates and maintains directory server user and group accounts.
v Abbreviated as SA. Responsible for providing the information in the rows in the

Installation and Upgrade Worksheet with a value of SA in the Role column.

Database administrator
v Creates, configures, maintains database installations and database or table

spaces.
v Responsible for creating database accounts needed by FileNet P8.
v For purposes of this documentation, the database administrator is expected to

have responsibilities regarding the JDBC data sources.
v Abbreviated as DBA. Responsible for providing the information in the rows in

the Installation and Upgrade Worksheet with a value of DBA in the Role column.

Application server administrator
v Responsible for providing the application servers required by FileNet P8.
v Responsible for application server administrative accounts.
v Abbreviated as ASA. Responsible for providing the information in the rows in

the Installation and Upgrade Worksheet with a value of ASA in the Role column.

FileNet P8 administrator
v This role designation actually refers to the administrator or administrators who

perform regular maintenance of Content Platform Engine, Application Engine,
Workplace or Workplace XT.

v The administrator who logs on to IBM Administration Console for Content
Platform Engine by using the gcd_admin account or an object_store_admin account
is considered a FileNet P8 administrator.

v Abbreviated as P8A. Responsible for providing the information in the rows of
the Installation and Upgrade Worksheet with a value of P8A in the Role column.
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Using the installation and upgrade worksheet
The Installation and Upgrade Worksheet is a Microsoft Excel spreadsheet
(p8_worksheet.xls). The worksheet describes the properties and parameters
required to complete IBM FileNet P8 installation, upgrade, and configuration
programs, and provides a way to record the values you assign to these properties
and parameters.

Administrators who are preparing the environment for installation or upgrade of
IBM FileNet P8 components must use the worksheet during their preparation tasks
to record the appropriate values and provide them to the Installation
Administrator who runs the installation or upgrade programs.

Some of the features of the Installation and Upgrade Worksheet are:
v Instructions: describes the worksheet and includes a button that runs the

Customize Worksheet macro.
v The two highlighted columns, Property or Parameter and ENTER YOUR

VALUE HERE, provide the simplest view of the requirement. The others add
identifying information and help you sort and filter the rows usefully.

v The Role column assigns each row to an administrator and uses the following
acronyms:
– ITA: Information Technology Administrator
– ASA: Application Server Administrator
– DBA: Database Administrator
– SA: Security Administrator
– P8A: IBM FileNet P8 Administrator

v Property definitions are contained in the column titled Description.
v Some rows, though not all, contain a hyperlink in the IC help link column.

Click this hyperlink to run a query against the IBM Information Center, which
opens with the Search Results pane showing the topics that contain the words in
the query phrase. Browse the search results until you have enough information
to be able to enter a value in the Worksheet row.
“Running the Customize Worksheet macro”
The Customize Worksheet macro lets you extract only those rows that describe
your environment.
“Autofiltering and sorting the Worksheet” on page 4
There are several ways to organize the Worksheet to make finding properties
and entering values easier.

Running the Customize Worksheet macro
The Customize Worksheet macro lets you extract only those rows that describe
your environment.

Important: For support of the full range of built-in filter and macro features, use
Microsoft Excel to view the Installation and Upgrade Worksheet file. You can use
other spreadsheet programs to view the file; however, filter and macro support can
vary. For example, in Calc from OpenOffice.Org, the column filters work as
expected, but the Customize Worksheet button does not.
To run the Customize Worksheet macro:
1. Open the Installation and Upgrade Worksheet (p8_worksheet.xls) and click the

Instructions worksheet (also called a tab).
2. Scroll down until you see the button representing the Customize Worksheet

macro. Click the button.

Planning and preparing for installation 3



3. Select the components and options that describe the environment you are
preparing for IBM FileNet P8.
v Installation or Upgrade
v FileNet P8 Components
v Application Server type
v Operating system
v Database type
v Directory Server type
v Number of object stores (adds new sets of rows for creating additional data

sources)
v Name of customized sheet

4. Click OK. The macro copies the rows that fulfill your selection criteria into a
new worksheet with the name you entered. Enter the values for your
environment into this new worksheet.

5. Click the name of the new worksheet at the bottom of the Excel window. Add
your preparation values into this new worksheet.

6. Notice that the new worksheet has buttons at the top titled Show Installer
View and Show Full View, depending on its state. The Show Installer View
displays only those columns that you need while running installation or
configuration programs.

Autofiltering and sorting the Worksheet
There are several ways to organize the Worksheet to make finding properties and
entering values easier.

AutoFiltering is a quick way to display only those rows that meet a certain criteria.
To use AutoFilter:
1. Make sure AutoFiltering is enabled. (Select the entire row with the column

headers, then click Data > Filter > Autofilter.) AutoFilter arrows will appear to
the right of the column labels.

2. Click the AutoFilter arrow in the Installation or Configuration Program
column header and select the program you are interested in (for example, PE
installer).

3. Click the AutoFilter arrow in the Setup Type column header, select Custom,
and specify Setup Type contains Installation.

4. For a custom AutoFilter, click the AutoFilter in any column header, select
Custom, and specify Setup Type contains “Installation”.

5. To turn off AutoFiltering in a column, click the column AutoFilter arrow and
select (All).

6. To reorder rows alphabetically, do a Sort:
a. Click anywhere in a column, for example, Column A Role.

The only possible values in the Role column are ASA, SA, DBA, ITA, and
P8A. Sorting on Role therefore groups the rows by this attribute, in
alphabetic order. Several other columns also have a limited number of
possible values which means they can be usefully sorted.

b. Click the Sort Ascending icon in the Excel toolbar, or use the Data > Sort
menu command. The rows sort on Role.
Sorting the Worksheet reassigns row numbers. If you refer to rows by
number, be aware that row numbers change if you change the sort order.
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Performing required preparation tasks
You must complete all of the required preparation tasks before you start the
installation.

Attention: Perform the preparation tasks in this section. Follow the instructions
in Plan and Prepare Your Environment for IBM FileNet P8 for the components you are
installing.

To prepare your environment for an IBM FileNet Case Analyzer installation,
perform the required preparation tasks for the components you plan to install.

Use the Installation and Upgrade Worksheet for your environment. All
administrators must fill out the worksheet with the relevant information as
described in “Using the installation and upgrade worksheet” on page 3.

“Installation administrator tasks”
The Installation administrator must prepare Case Analyzer to connect to a
single object store or to a Legacy Workflow System and whether to analyze
production system data or simulated data.
“IT administrator tasks” on page 6
The IT administrator must prepare the network and operating systems for the
Case Analyzer installation.
“Security administrator tasks” on page 7
The Security administrator must prepare the security environment for Case
Analyzer including creating user accounts.
“Database administrator tasks” on page 8
The Database administrator must prepare the databases that are required for
Case Analyzer including creating database accounts and collecting database
information.

Installation administrator tasks
The Installation administrator must prepare Case Analyzer to connect to a single
object store or to a Legacy Workflow System and whether to analyze production
system data or simulated data.

The Installer administrator must consider the following tasks.
“Planning your installation”
You can install Case Analyzer to connect to a single object store or to a Legacy
Workflow System.
“Language support for Case Analyzer” on page 6
Language support for Case Analyzer is fully Unicode enabled to support
multiple languages.

Planning your installation
You can install Case Analyzer to connect to a single object store or to a Legacy
Workflow System.

The installed IBM FileNet Case Analyzer can process all of the regions in the object
store or Legacy Workflow System. You no longer need to install multiple instances
of Case Analyzer to process multiple Content Platform Engine databases because
the Case Analyzer Publishing Service is now part of Content Platform Engine
where you configure the multiple databases.
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“Case Analyzer installation use cases”
The Case Analyzer installation use cases can analyze production system data or
simulated data.
“Case Analyzer limitations”
Before you start the Case Analyzer installation, you must understand the
system limitations that might affect your installation.

Case Analyzer installation use cases:

The Case Analyzer installation use cases can analyze production system data or
simulated data.

There are two typical use cases for IBM FileNet Case Analyzer:
v Production Case Analyzer is for analyzing data from a production system. In

addition, production Case Analyzer can provide production input data to IBM
FileNet Process Simulator.

v Simulation Case Analyzer is for analyzing simulation data. It is populated with
the information that it received from Process Simulator.

Case Analyzer limitations:

Before you start the Case Analyzer installation, you must understand the system
limitations that might affect your installation.

IBM FileNet P8 does not support:
v Storing both production data and simulation data in the same IBM FileNet Case

Analyzer store. Store simulation data in a Case Analyzer store of type
Simulation and production data in a Case Analyzer store of type Production.

v Collocating IBM FileNet Process Simulator and Case Analyzer where Case
Analyzer is used in a production context. Collocation of Process Simulator and
Case Analyzer is supported where Case Analyzer is used in a simulation
context.

Language support for Case Analyzer
Language support for Case Analyzer is fully Unicode enabled to support multiple
languages.

You can set up IBM FileNet Case Analyzer in any multilingual Content Platform
Engine environment to support all languages.

For more information about setting up your non-English environment, see
Preparing non-English environments for installing FileNet P8 in Plan and Prepare
Your Environment for IBM FileNet P8.

IT administrator tasks
The IT administrator must prepare the network and operating systems for the Case
Analyzer installation.

The Information Technology administrator must complete the following tasks.
“Ensuring minimum required disk space and temp space for installation” on
page 7
Before you begin the Case Analyzer installation, ensure that your system has
the required disk space and temp space.
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“Configuring Case Analyzer ports”
You must configure the Case Analyzer ports on Windows or UNIX.
“Configuring the time and date”
The FileNet Case Analyzer components must be configured for the same time
zone and time of day.

Ensuring minimum required disk space and temp space for
installation
Before you begin the Case Analyzer installation, ensure that your system has the
required disk space and temp space.

To determine the disk space and temp space requirements for an IBM FileNet Case
Analyzer installation, see IBM FileNet P8 Hardware and Software Requirements.

Configuring Case Analyzer ports
You must configure the Case Analyzer ports on Windows or UNIX.

To configure IBM FileNet Case Analyzer ports:
1. In the IBM FileNet P8 Platform Installation and Upgrade Guide, go to FileNet P8

Ports.
2. Select Content Platform Engine ports to see the required ports for Case

Analyzer.
3. Select the link to topics that contain port information for other FileNet P8

system components if needed.

Configuring the time and date
The FileNet Case Analyzer components must be configured for the same time zone
and time of day.

Ensure that the following components are in the same time zone and synchronized
to the same time:
v Content Platform Engine server (Content Platform Engine)
v Case Analyzer Database server (Case Analyzer database)
v Case Analyzer Analysis Server (OLAP Database) if separate from the Content

Platform Engine and Case Analyzer database
v Content Platform Engine database server

Security administrator tasks
The Security administrator must prepare the security environment for Case
Analyzer including creating user accounts.

The Security administrator must complete the following tasks.
“Creating required users for run time”
You create or identify the following runtime users as part of the IBM FileNet
Case Analyzer configuration only if the user has enabled OLAP integration for
the Case Analyzer store.

Creating required users for run time
You create or identify the following runtime users as part of the IBM FileNet Case
Analyzer configuration only if the user has enabled OLAP integration for the Case
Analyzer store.

OLAP integration can only be enabled for Case Analyzer databases running on
Microsoft SQL Server.
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the ca_olap_administrator must:
v Be a domain Windows user under the following conditions:

– Case Analyzer database is remote from either the Case Analyzer SSAS
Connector or from Microsoft SQL Server Analysis Services.

– Case Analyzer SSAS Connector is remote from Microsoft SQL Server Analysis
Services.

v Be added as a Microsoft SQL Server Login user for the Case Analyzer database
with db_owner privileges.
Attention: Ensure that you configure the Microsoft SQL Server Analysis
Services service to log in as the ca_olap_administrator user.

v Have administrative privileges on the Case Analyzer OLAP database.

Database administrator tasks
The Database administrator must prepare the databases that are required for Case
Analyzer including creating database accounts and collecting database information.

The Database administrator must complete the following tasks.
“Creating Case Analyzer database accounts”
Use your database tools to create new or designate existing database accounts
for Case Analyzer.
“Prepare for the database installation” on page 11
When preparing for the database installation, consider the following database
information.
“Collect the required database information” on page 11
Before you install and configure Case Analyzer, you must collect the database
information you are going to need during installation and configuration. Add
the information that you collect to the Installation and Upgrade Worksheet.
“Preparing Microsoft SQL Server” on page 11
Plan and prepare your Microsoft SQL Server database for a Case Analyzer
installation.
“Preparing Oracle server” on page 14
Plan the Oracle installation and configuration, install the software, and
configure database components for IBM FileNet P8 components after reviewing
the requirements.
“Preparing DB2 for Linux, UNIX and Windows servers” on page 16
Plan and prepare your IBM DB2® for Linux, UNIX and Windows servers for
FileNet P8 installation.

Creating Case Analyzer database accounts
Use your database tools to create new or designate existing database accounts for
Case Analyzer.

Accounts are referred to in documentation in the following ways:
v By a display name; for example, Database User Name. An account's display

name is how the FileNet P8 user interface, such as a setup program or dialog
box, refers to the account. Many accounts have both a display name and a
variable.

v By a variable designator; for example cpe_db_user, using lower-cased italics and
underscores. The variable is intended to show that you must designate your
own account to act in the role described by the variable. The variable is the
unique identifier for a particular account.
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If you see a reference to an account that you do not understand, search the
Information Center for that reference.

Create the following users and groups. After the IT Administrator creates operating
system users and groups for DB2 databases, you must grant database permissions
to those accounts.

“Creating a Case Analyzer database user for DB2 for Linux, UNIX and
Windows”
An operating system account on the database server that Case Analyzer uses to
access DB2(r) for Linux(r), UNIX(r) and Windows(r) databases containing the
GCD and object stores
“Creating a Case Analyzer database user for Oracle”
A database user account that Case Analyzer uses to connect to Oracle databases
containing the GCD and object stores.
“Creating a Case Analyzer database user for SQL Server” on page 10
A database user account that Case Analyzer uses to connect to SQL Server
databases containing the GCD and object stores.

Creating a Case Analyzer database user for DB2 for Linux, UNIX and Windows:

An operating system account on the database server that Case Analyzer uses to
access DB2(r) for Linux(r), UNIX(r) and Windows(r) databases containing the GCD
and object stores

After you create the Content Platform Engine database user for DB2 for Linux,
UNIX and Windows as described in Creating a Content Platform Engine database
user for DB2 for Linux, UNIX, and Windows, you must create the Case Analyzer
database administrator user.

To create a Case Analyzer database user for DB2 for Linux, UNIX and Windows:
1. Create the following operating system account:

Case Analyzer database user for DB2 for Linux, UNIX and Windows

Unique identifier
ca_db_administrator

Description
The IT administrator (ITA) creates this operating system
account, after which the database administrator (DBA) grants it
additional database permissions. Separate accounts can be used
for each Case Analyzer object store, but are not required.

Do not create databases with the RESTRICTIVE option.

Minimum required permissions
No additional parameters are required other than Content
Platform Engine database user permissions.

2. Record this value in your customized Installation and Upgrade Worksheet. To
find this property, search the worksheet for instances of ca_db_administrator.

Creating a Case Analyzer database user for Oracle:

A database user account that Case Analyzer uses to connect to Oracle databases
containing the GCD and object stores.
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After you create the Content Platform Engine database user for Oracle as described
in Creating a Content Platform Engine database user for Oracle, you must create
the Case Analyzer database administrator user.
1. Create the following database account:

Case Analyzer database user (Oracle)

Unique identifier
ca_db_administrator

Description
The tablespace owner accounts that Case Analyzer uses to
access Oracle. Use one account for the Case Analyzer object
store tablespaces.

Minimum required permissions
In addition to the Content Platform Engine database user
permissions. grant each ca_db_administrator the following
permission:
v CREATE PROCEDURE

2. Record this value in your customized Installation and Upgrade Worksheet. To
find this property, search the worksheet for instances of ca_db_administrator.

Creating a Case Analyzer database user for SQL Server:

A database user account that Case Analyzer uses to connect to SQL Server
databases containing the GCD and object stores.

After you create the Content Platform Engine database user for SQL Server as
described in Creating a Content Platform Engine database user for SQL Server, you
must create the Case Analyzer database administrator user.
1. Create the following database account:

Case Analyzer database user (SQL Server)

Unique identifier
ca_db_administrator

Description
The database accounts that Case Analyzer uses to access SQL
Server. nt for the GCD and object store databases.

ca_db_administrator must be a SQL Server account. It does not
have to be an account in the configured directory service.

Minimum required permissions

In addition to the Content Platform Engine database user
permissions, grant each ca_db_administrator the following
permissions:
v db_securityadmin
v Bulk admin

Add these accounts to SQL Server's master database and grant
the public role to each. When you perform the procedure
“Configuring the JDBC distributed transaction components”,
these accounts will also be granted the SqlJDBCXAUser role.

2. Record this value in your customized Installation and Upgrade Worksheet. To
find this property, search the worksheet for instances of ca_db_administrator.
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Prepare for the database installation
When preparing for the database installation, consider the following database
information.

IBM FileNet Case Analyzer uses the following two databases.

Table 1. Databases used by the Case Analyzer

Database Database name

Case Analyzer database User defined

Case Analyzer OLAP database

This optional database is used when the
Case Analyzer Store is using a Microsoft
SQL Server database and OLAP integration
is enabled.

User defined

Ensure that Case Analyzer database files are on an NTFS-formatted drive. The
Case Analyzer database files can grow large over time. To allow the file sizes to
grow beyond 4 GB, the database file must be located on a drive that is formatted
as NTFS.

For best practices, it is recommended that you put the Case Analyzer tables and
the Content Platform Engine tables in separate databases to better enable backup
and recovery of data.

Collect the required database information
Before you install and configure Case Analyzer, you must collect the database
information you are going to need during installation and configuration. Add the
information that you collect to the Installation and Upgrade Worksheet.

IBM FileNet Case Analyzer supports publishing to the Microsoft SQL Server, DB2
for Linux, UNIX and Windows, and Oracle databases.

Collect the following database information for your Case Analyzer installation and
configuration:
v The dedicated TCP/IP port number of the database instance used by the Case

Analyzer
v The name of the database server, if Case Analyzer is configured with a remote

database
v The ca_db_administrator user ID and password for the Case Analyzer database

instance. This ID is the user created in “Creating required users for run time” on
page 7

v If you use OLAP integration with Microsoft SQL Server:
– The name of the Microsoft SQL Server Analysis Services server, if separate

from the database server
– The name of the Microsoft SQL Server Analysis Services instance, if Analysis

Services is configured as a named instance

Preparing Microsoft SQL Server
Plan and prepare your Microsoft SQL Server database for a Case Analyzer
installation.

Consider the following information when you prepare the Microsoft SQL Server
database:
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v Create the Case Analyzer OLAP databases before you install Case Analyzer.
Attention: You need this database only if you intend to enable OLAP
integration on the Case Analyzer Store, otherwise it is not required.

v Install the Case Analyzer database and the Case Analyzer OLAP database
collocated on the same server or on separate servers.

v Configure the Microsoft SQL Server database for Mixed Mode authentication
v During the Microsoft SQL Server installation, record the values for the following

settings. You use this information during the Case Analyzer Engine installation.
For more information, see “Installing Case Analyzer components interactively”
on page 22 or “Installing Case Analyzer components silently” on page 22.
– Case Analyzer database

- Server name
- Instance name
- TCP/IP port assigned to the database instances. See “Configuring Case

Analyzer ports” on page 7
- Name and password of the pa_administrator user that Case Analyzer is

used to access the database. See “Creating required users for run time” on
page 7

– Microsoft SQL Server Analysis database
- Analysis Services server name (if separate from Case Analyzer database

Server)
- OLAP instance name

In addition to the following instructions, see the Microsoft SQL Server installation
instructions.

To configure Microsoft SQL Server:
1. Select the database collation settings. Specify one of the following:

v Dictionary order, not case-sensitive, for use with 1252 Character Set (or any
not case-sensitive Microsoft SQL Server collation). Not case-sensitive collation
is the Microsoft default and the setting most used in IBM FileNet P8
environments (because it offers search results without regard to character
case).

v Dictionary order, case-sensitive, for use with 1252 Character Set (or any
case-sensitive Microsoft SQL Server collation). Select case-sensitive Microsoft
SQL Server collation only if you know that your site requires searches that
must differentiate uppercase from lowercase characters (in property choice
lists, folder names, etc.).

Important: Select your Microsoft SQL Server collation setting carefully.
Switching collation settings after installation can be difficult and
time-consuming. Especially if you want to switch from case-sensitive to not
case-sensitive collation after significant user activity. Be aware that if you have
a case-sensitive database and you want to perform a not case-sensitive search
programmatically or otherwise, you might encounter serious performance
degradation on Microsoft SQL Server. The database cannot use column indexes
in these cases.

2. Define a static port number.
If the Case Analyzer database instance is not the only instance on the server,
you must assign a non-conflicting static port number for the Case Analyzer
database instance using Microsoft SQL Server Configuration Manager. For
information, see your Microsoft SQL Server Documentation.
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3. Download and install the required Microsoft SQL Server Service Packs, as
indicated in IBM FileNet P8 Hardware and Software Requirements.

4. Verify that the ca_olap_administrator user has been given administrative
privileges on the Case Analyzer OLAP server.
See “Adding a user to the server role in Microsoft SQL Server Analysis
Services.”
“Adding a user to the server role in Microsoft SQL Server Analysis Services”
You must add a user to the server role in Microsoft SQL Server Analysis
Services to perform OLAP operations.
“Enabling Microsoft SQL Server XA transactions”
Configure the Windows server to enable Microsoft SQL Server XA transactions.
“Preparing the Microsoft SQL Server client” on page 14
You can use the Case Analyzer SSAS Connector to access Microsoft SQL Server
Analysis Services (SSAS) to perform OLAP operations on Case Analyzer
reporting. If the Case Analyzer SSAS Connector is running remote from the
Microsoft SQL Server Analysis Services server, the Microsoft SQL Server client
must be installed on the Case Analyzer SSAS Connector server.

Adding a user to the server role in Microsoft SQL Server Analysis Services:

You must add a user to the server role in Microsoft SQL Server Analysis Services
to perform OLAP operations.

OLAP operations on Excel Reporting and Cognos® Business Intelligence reporting
are supported on IBM FileNet Case Analyzer if you are using a Microsoft SQL
Server database in a Windows environment. DB2 for Linux, UNIX and Windows
and Oracle databases use IBM FileNet Case Monitor for reporting, not Excel
Reporting or Cognos Business Intelligence.

This procedure is referenced from “Creating required users for run time” on page
7.

To add the user to the server role in Microsoft SQL Server Analysis Services
(SSAS):
1. Open Microsoft SQL Server Management Studio.
2. In the Connect to Server window, connect to the instance of Microsoft SQL

Server Analysis Services that you are using.
3. In Object Explorer, right-click your Microsoft SQL Server Analysis Services

instance name and select Properties.
4. On the Analysis Services Properties page, in the Select a page pane, click

Security. Users and Groups that are members of the server role appears in a
list.

5. Click Add.
6. In the Select Users or Groups page, go to the Enter the object names to select

field and enter ca_olap_db_administrator as the name of the account that you are
adding to the server role.

7. Click Check Name to verify that the account exists.
8. Click OK.

Enabling Microsoft SQL Server XA transactions:

Configure the Windows server to enable Microsoft SQL Server XA transactions.
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Perform these steps on every Microsoft SQL Server that will contain an IBM
FileNet Case Analyzer database.

To enable Microsoft SQL Server XA transactions:
1. From Control Panel, open Administrative Tools, and then open Component

Services.
2. Expand Component Services, right-click My Computer, and then select

Properties.
3. Expand Distributed Transaction Coordinator and right-click Local DTC.
4. Click the MSDTC tab, and then click Security Configuration.
5. Select the Enable XA Transactions check box, and then click OK to restart the

Microsoft DTC service.
6. Click OK again to close the Properties dialog box, and then close Component

Services.
7. Stop and then restart the Microsoft SQL Server.

Preparing the Microsoft SQL Server client:

You can use the Case Analyzer SSAS Connector to access Microsoft SQL Server
Analysis Services (SSAS) to perform OLAP operations on Case Analyzer reporting.
If the Case Analyzer SSAS Connector is running remote from the Microsoft SQL
Server Analysis Services server, the Microsoft SQL Server client must be installed
on the Case Analyzer SSAS Connector server.

To install Microsoft SQL Server client on the Case Analyzer SSAS Connector server:
1. Install the Microsoft SQL Server client software.

a. Log on to the Case Analyzer SSAS Connector server with an account that
has local administrator privileges.

b. Install the Microsoft SQL Server software using the following options:
v In the Components to Install screen, select Workstation Components,

Books Online and development tools.
v In the Feature Selection dialog, select the following Client Components:

– Connectivity Components
– Management Tools

v Accept the defaults for the rest of the installation.
2. Download and install the required Microsoft SQL Server 2008 Service Pack, as

indicated in the IBM FileNet P8 Hardware and Software Requirements.
3. Verify the connection between the Microsoft SQL Server client installation and

the database computer using either of the following methods:
v At a command prompt type:

sqlcmd -E -S servername [\ instance_name ]

v Use Microsoft SQL Server Management Tools to test the connection to the
Analysis Server.

If the connection fails, resolve the problem before you proceed.

Preparing Oracle server
Plan the Oracle installation and configuration, install the software, and configure
database components for IBM FileNet P8 components after reviewing the
requirements.
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There are some restrictions when you run IBM FileNet Case Analyzer on an Oracle
Server database:
v You can only use the Case Analyzer store for IBM FileNet Case Monitor.
v You cannot enable OLAP integration for the Case Analyzer store.
v You cannot use Case Analyzer SSAS Excel reports or Case Analyzer Cognos

Business Intelligence reports.
“Creating an Oracle database”
Create one or more databases, depending on whether one or more IBM FileNet
P8 components will share the database.
“Configuring automatic transaction recovery”
In a distributed database environment, Oracle MTS Recovery Service
(automatically installed with Oracle Services for Microsoft Transaction Server)
can resolve in-doubt transactions on the computer that started the failed
transaction.
“Configuring Oracle XA transactions” on page 16
Configure Oracle XA transactions for Case Analyzer by running several Oracle
SQL scripts.

Creating an Oracle database:

Create one or more databases, depending on whether one or more IBM FileNet P8
components will share the database.

FileNet P8 requires the following settings for Oracle databases:

Database configuration type
If a database is dedicated to Content Platform Engine Transaction
Processing (also known as OLTP) is the required configuration type.

Server process type
Dedicated Server Mode

Database character set
Set the regular character set to AL32UTF8. It is not required to set the
national character set (NLS_NCHAR_CHARACTERSET) to a specific value.
You can take the default. The national character set applies to the data
types NCHAR / NVARCHAR2 / NCLOB which the Content Platform
Engine does not use.

Record the values for the Database server name, Database name, and the Database
port number in your customized Installation and Upgrade Worksheet. To find
these properties, set the Autofilter for Column E Installation or Configuration
Program for CM: Configure GCD JDBC Data Sources. Then set the Autofilter for
Column DISV Component Vendor to Oracle.

Configuring automatic transaction recovery:

In a distributed database environment, Oracle MTS Recovery Service
(automatically installed with Oracle Services for Microsoft Transaction Server) can
resolve in-doubt transactions on the computer that started the failed transaction.
v Enable automatic transaction recovery by performing the tasks shown in the

Scheduling Automatic Microsoft Transaction Server Recovery section of Oracle
Services for Microsoft Transaction Server Developer's Guide (Oracle Part Number
A95496-01).
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v If you are using an Oracle Fail Safe configuration, perform the procedure shown
in the Modifying Registry Values for Oracle Fail Safe Configurations section of
Oracle Services for Microsoft Transaction Server Developer's Guide (Oracle Part
Number A95496-01).

Configuring Oracle XA transactions:

Configure Oracle XA transactions for Case Analyzer by running several Oracle
SQL scripts.

To configure Oracle XA transactions:
1. Log on the Oracle database as either SYSOPER or SYSDBA.
2. Locate and run the initxa.sql script in the ORACLE_HOME\javavm\install

directory.
3. If the script fails to run because the database memory space is too small, locate

and run the initjvm.sql script in the ORACLE_HOME\javavm\install directory.
Additional memory-related parameters might need to be adjusted to
successfully run this script.

Preparing DB2 for Linux, UNIX and Windows servers
Plan and prepare your IBM DB2 for Linux, UNIX and Windows servers for FileNet
P8 installation.

There are some restrictions when you run IBM FileNet Case Analyzer on a DB2
database:
v You can only use the Case Analyzer store for IBM FileNet Case Monitor.
v You cannot enable OLAP integration for the Case Analyzer store.
v You cannot use Case Analyzer SSAS Excel reports or Case Analyzer Cognos

Business Intelligence reports.

The following are planning considerations for DB2 for Linux, UNIX and Windows:
v DB2 for Linux, UNIX and Windows version 9.7 is required for Process Engine to

support GB18030 character sets.
v IBM FileNet P8 does not support partitioned DB2 databases or databases created

with the RESTRICTIVE clause (or, from the Control Center, with Restrict access
to system catalogs selected in the Create Database Wizard).

v Determine whether you want to use a dedicated or shared database. In this
regard:
– Content Engine and Process Engine can share a database server, or they can

each have a dedicated (unique) database servers.
– Content Engine and Process Engine can each have a dedicated DB2 instance,

or they can share an instance with one another or with non-IBM FileNet P8
applications.

– Assign unique databases to the Content Engine global configuration database
and object stores. Although you can configure multiple Content Engine object
stores in a single DB2 database, you should configure each object store in a
separate database. If you configure object stores in separate databases, you
have more flexibility and control with security access, backup scheduling and
execution, updates, and scheduled outages.

– It is a best practice to create one Process Engine isolated region in a database
for simplification of backup, administration, and support activities. Create one
isolated region per database and configure separate Process Engine virtual
servers for each database.
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– A Content Engine object store and a single Process Engine isolated region can
share a database. This configuration is required for new FileNet P8
installations with IBM Case Manager. Where IBM Case Manager will be
added to an existing FileNet P8 configuration, this shared database is
recommended. The table spaces in the database can optionally be shared.

v Plan to use automatic storage for table spaces. For performance reasons, IBM
recommends that you create table spaces using automatic storage, rather than
database managed or system managed table spaces for Process Engine and
Content Engine.

v Plan to use SERVER authentication.
v Set the DB2 codeset to UTF-8.
v Set the page size to 32 KB.
v Determine the maximum size of the content elements your users store. The size

affects setting up database storage areas or file storage areas. When you create
an object store, a database storage area is provided by default, allowing you to
store content as database BLOBs. You can also create one or more file storage
areas to store content on local or remote file systems. If your users store large
individual documents or other content elements, use only file storage areas.
Otherwise, users can encounter memory-related errors when retrieving or
indexing the large content.

v Determine whether the configuration will include IBM DB2 pureScale®. To
configure the Process Engine JDBC URL, you will need the names of two
pureScale servers as well as the database port.

Important: Controlled tests with limited concurrency exhibited errors when run
with files that were 300 MB or larger. Factors affecting this file-size limitation
include driver and application server memory demands, other activity such as
concurrent retrieval or indexing of large content, and JVM memory allocations.

“Installing DB2 for Linux, UNIX and Windows and creating DB2 instances”
Create DB2 for Linux, UNIX and Windows instances for Case Analyzer and set
several instance values.

Installing DB2 for Linux, UNIX and Windows and creating DB2 instances:

Create DB2 for Linux, UNIX and Windows instances for Case Analyzer and set
several instance values.

To install DB2 for Linux, UNIX and Windows and create DB2 instances:
1. Install the IBM DB2 for Linux, UNIX and Windows software. Make note of the

TCP/IP port number assigned to the instance or instances. The port number
assigned can be found in the /etc/services file, associated with the DB2
instance(s) just created. After a successful installation, the DB2 instance should
be up and running.

2. Refer to the IBM FileNet P8 Hardware and Software Requirements for required
operating-system and database patch sets, and service packs.

3. Content Engine and Process Engine can share an instance, or each engine can
have its own instance. Create the appropriate instances if they do not exist.

4. Set TCP/IP as the default protocol.
5. Set the DB2_OPTPROFILE variable to YES.
6. (DB2 version 9.7 only) Set the DB2_WORKLOAD variable to FILENET_CM.
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Installing and configuring Case Analyzer

The Case Analyzer services are installed as part of the Content Platform Engine
installation. After you install the Content Platform Engine software, you can install
the Case Analyzer components by using the IBM Case Foundation installation
program.

Restriction: Do not install IBM FileNet Case Analyzer, formerly known as Process
Analyzer, unless it is supported at the release levels of your FileNet P8
environment. For information, see the IBM FileNet P8 Hardware and Software
Requirements and the IBM FileNet P8 Compatibility Matrix documents.

This section contains the installation and configuration topics for the Case
Analyzer components.

“Enabling Case Analyzer services”
There are no specific installation procedures for the Case Analyzer services
because these services are installed as part of Content Platform Engine. After
Content Platform Engine is installed, you can enable Case Analyzer services at
the domain, site, virtual server or server level.
“Installing Case Analyzer components” on page 20
You can select and install the Case Analyzer components that you want by
running the IBM Case Foundation installation wizard. Or you can enter the
installation values for the Case Analyzer components into an input response file
and run the installation program from a command line.
“Configuring the Case Analyzer SSAS Connector” on page 23
If you installed the Case Analyzer SSAS Connector and plan to access Microsoft
SQL Server Analysis Services (SSAS) by using a non-default RMI port, you
must configure the Case Analyzer SSAS Connector to use the desired RMI port
number. If you choose to use the default RMI port number, no other
configuration steps are required.
“Create an initial Case Analyzer store” on page 23
You must create an initial Case Analyzer store. The Case Analyzer services
process data from the Content Platform Engine audit and event logs and stores
the analytical results to this Case Analyzer store.
“Configuring Case Analyzer components” on page 24
You must configure the Case Analyzer components that you installed.
“Installing Case Analyzer software updates” on page 29
Perform the procedure in this topic for each Case Analyzer instance to install
software updates such as a mod release, fix pack, or interim fix.

Enabling Case Analyzer services
There are no specific installation procedures for the Case Analyzer services because
these services are installed as part of Content Platform Engine. After Content
Platform Engine is installed, you can enable Case Analyzer services at the domain,
site, virtual server or server level.

The following software must be installed before you can enable and run IBM
FileNet Case Analyzer services:
v IBM Case Foundation
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v Case Analyzer SSAS Connector if you plan to use Case Analyzer Excel Reports
or Cognos Business Intelligence

Case Analyzer services support publishing to the Microsoft SQL Server, DB2 for
Linux, UNIX and Windows, and Oracle databases.

To enable Case Analyzer services in Content Platform Engine:
1. Open IBM Administration Console for Content Platform Engine and select the

level at which you want to enable Case Analyzer services.
2. Click the Workflow Subsystem tab.
3. Select the Case Analyzer enabled option and click OK.

For more information about inheritance and hierarchy levels of domain properties,
see Inheritance and server hierarchy levels.

Installing Case Analyzer components
You can select and install the Case Analyzer components that you want by running
the IBM Case Foundation installation wizard. Or you can enter the installation
values for the Case Analyzer components into an input response file and run the
installation program from a command line.

You can install the components that are shown in the following table by running
the IBM Case Foundation installation program. Note that some of the components
can be installed only on Windows.

Table 2. IBM Case Foundation components

Component Description

IBM Case Foundation Install this software on a Content Platform
Engine to enable full workflow processing
capabilities.

Tools Install the tools on the Content Platform
Engine server after installing the Content
Platform Engine server. Alternatively, install
only the Content Platform Engine tools on a
remote workstations, then install the IBM
Case Foundation tools.
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Table 2. IBM Case Foundation components (continued)

Component Description

Case Analyzer Components Choose from the following Case Analyzer
components:

v Case Monitor Project: integrates with IBM
Cognos Real-time Monitoring to monitor
the current state of case and workflow
processes in near real time.

v Cognos Business Intelligence project:
generates Cognos Business Intelligence
reports for statistical information from
Content Platform Engine or Process
Simulator

v Excel Reports: generates Excel reports for
statistical information from Content
Platform Engine or Process Simulator

v SSAS OLAP Connector: provides access to
Microsoft SQL Server Analysis Services
(SSAS) to perform OLAP operations on
Cognos Business Intelligence reporting

The Excel Reports and SSAS OLAP
Connector options only appear on Microsoft
Windows platforms. See the IBM FileNet Case
Analyzer Installation and Upgrade Guide for
more information.

“Install prerequisite software”
Before you install the Case Analyzer Excel Reports component, verify that the
computers and user workstations that run Case Analyzer Excel reports have the
required software installed on them.
“Installing Case Analyzer components interactively” on page 22
You can use the installation wizard to install Case Analyzer components
interactively.
“Installing Case Analyzer components silently” on page 22
You can install the Case Analyzer components silently by modifying the values
in the silent installation response file and running the IBM Case Foundation
installation program from a command line.

Install prerequisite software

Before you install the Case Analyzer Excel Reports component, verify that the
computers and user workstations that run Case Analyzer Excel reports have the
required software installed on them.

All of the workstations that are going to access IBM FileNet Case Analyzer Excel
reports must have:
v Microsoft Excel with query analyzer (MS Query) and pivot table support

installed.
For Excel version requirements, see IBM FileNet P8 Hardware and Software
Requirements. See Microsoft documentation for instructions on how to install and
configure Microsoft Excel.

v Microsoft SQL Server add-ons:
– Microsoft Core XML Services (MSXML)
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– The appropriate Microsoft SQL Server Analysis Services OLE DB Provider
based on the Analysis version must be installed

The Microsoft SQL Server add-ons are available for download from Microsoft.
For details, see IBM FileNet P8 Hardware and Software Requirements.

Installing Case Analyzer components interactively
You can use the installation wizard to install Case Analyzer components
interactively.

To install IBM FileNet Case Analyzer components interactively:
1. Open your completed Installation and Upgrade Worksheet file that contains the

parameter values to specify in the Case Analyzer installation.

Tip: In the worksheet file, verify that the Data > Filter > AutoFilter is enabled.
To view only Case Analyzer values, filter by CA Components Installer in the
Installation or Configuration Program column.

2. Log on as cpe_install_user to the computer where you are going to install Case
Analyzer components.

3. Access the IBM Case Foundation 5.2.0 software package in the installation
media.

4. Run the installation program 5.2.0-P8CaseFoundation-WIN.EXE to start the
installation process.

5. Select the Case Analyzer components that you want to install.
6. Complete the Case Analyzer components installation screens by using the

values from your worksheet.
7. When the installation completes, navigate to the C:\Program

Files\IBM\FileNet\Case Foundation directory.
8. Open the casefoundation_install_log_5.2.0.txt log file and check for errors

to verify the installation was successful.
9. Continue with “Configuring Case Analyzer components” on page 24.

Installing Case Analyzer components silently
You can install the Case Analyzer components silently by modifying the values in
the silent installation response file and running the IBM Case Foundation
installation program from a command line.

A sample response file for the IBM FileNet Case Analyzer components installation
is provide on the installation media. The file name is
CaseFoundation_silent_install.txt.

To install Case Analyzer components silently:
1. Open your completed Installation and Upgrade Worksheet file that contains the

parameter values to specify in the Case Analyzer installation.

Tip: In the worksheet file, verify that the Data > Filter > AutoFilter is enabled.
To view only Case Analyzer values, filter by CA Components Installer in the
Installation or Configuration Program column.

2. Log on as cpe_install_user to the computer where you are going to install Case
Analyzer components.

3. Access the IBM Case Foundation 5.2.0 software package in the installation
media.
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4. Edit the CaseFoundation_silent_install.txt file to reflect the installation
choices in your worksheet for the Case Analyzer components you want to
install.

5. Run the following command at a command prompt: 5.2.0-P8CaseFoundation-
WIN.EXE -i silent -f CaseFoundation_silent_install.txt.

6. When the installation completes, navigate to the C:\Program
Files\IBM\FileNet\Case Foundation directory.

7. Open the casefoundation_install_log_5.2.0.txt log file and check for errors
to verify the installation was successful.

8. Continue with “Configuring Case Analyzer components” on page 24.

Configuring the Case Analyzer SSAS Connector
If you installed the Case Analyzer SSAS Connector and plan to access Microsoft
SQL Server Analysis Services (SSAS) by using a non-default RMI port, you must
configure the Case Analyzer SSAS Connector to use the desired RMI port number.
If you choose to use the default RMI port number, no other configuration steps are
required.

The IBM FileNet Case Analyzer services that are running on Content Platform
Engine use the Java™ Remote Method Invocation (RMI) API to access the Case
Analyzer SSAS Connector to perform OLAP operations. By default, the Case
Analyzer SSAS Connector uses the RMI port number 32771. If you want to use an
RMI port number other than the default port number, you must complete the
following steps.

To configure the RMI port number on the Case Analyzer SSAS Connector:
1. Go to the Case Analyzer components installation directory. The default location

isC:\Program Files (x86)\IBM\FileNet\Case Foundation\Case Analyzer
components\SSAS OLAP Connector\jpa.

2. Open the olapconnector.properties file.
3. Edit the analyzer.rmiPortNumber parameter to contain the RMI port number

that you want the Case Analyzer SSAS Connector to use.
4. Save the change and close the olapconnector.properties file.
5. Restart the Case Analyzer SSAS Connector.

Create an initial Case Analyzer store
You must create an initial Case Analyzer store. The Case Analyzer services process
data from the Content Platform Engine audit and event logs and stores the
analytical results to this Case Analyzer store.

When creating an IBM FileNet Case Analyzer store, you can either reuse an
existing database connection. If your store must have its own database, you must
follow the same procedures required for creating the initial store. If you are reusing
an existing database connection, you can run the Case Analyzer store wizard
without any further preparations. For more information, see Creating a database
connection.

If you plan to use Case Analyzer Excel reports or Cognos Business Intelligence
project, the Case Analyzer SSAS Connector must be installed and configured on
your system. Then you must enable OLAP integration in the Case Analyzer store.
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The Case Analyzer store wizard leads you through the steps required to create an
object store. Follow the steps described in Creating a Case Analyzer Store to create
an initial store for Case Analyzer.

Configuring Case Analyzer components
You must configure the Case Analyzer components that you installed.

Before you can use IBM FileNet Case Analyzer, you must create an initial Case
Analyzer object store and complete the configuration procedures for the installed
components.

“Granting access rights to the Case Analyzer OLAP database”
Before a user can run Excel reports and Cognos Business Intelligence reports for
Case Analyzer, you must grant that user access to the Case Analyzer OLAP
database.
“Configuring Excel Reports for Case Analyzer” on page 25
If you installed the Excel Reports component, you must configure it to generate
reports from statistical information gathered from the Content Platform Engine
or Process Simulator.
“Configure Cognos Business Intelligence project for Case Analyzer” on page 26
If you installed the Cognos Business Intelligence project component, you must
configure it to generate reports from statistical information gathered from the
Content Platform Engine or Process Simulator.
“Configure Case Monitor project for Case Analyzer” on page 29
If you installed the Case Monitor project component, you must configure it to
integrate with IBM Cognos Real-time Monitoring to monitor the current state of
case and workflow processes.

Granting access rights to the Case Analyzer OLAP database
Before a user can run Excel reports and Cognos Business Intelligence reports for
Case Analyzer, you must grant that user access to the Case Analyzer OLAP
database.

Use the Microsoft SQL Server Management Studio to create roles and assign users.
See the online help for Microsoft SQL Server for more information and detailed
instructions.

Attention: Users who want to access reports must belong to the same domain as
the Microsoft SQL Server Analysis server. If a user does not belong to this same
domain, one option is to create a matching local user on the Microsoft SQL Server
Analysis server and assign the local user permissions to the Case Analyzer OLAP
database.

Important: Use this procedure only as a guide to creating roles because security
requirements differ at each site.

To grant access rights to the Case Analyzer OLAP database:
1. Go to Start > All Programs > Microsoft SQL Server 2008 > SQL Server

Management Studio.
2. Connect to your analysis services instance.
3. Expand Databases > OLAP_database_name.

Tip: If you are using the default instance, no instance name is appended.
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4. Right-click Roles and select New Role....
5. Give the user access to the OLAP cubes.

a. Enter the Role Name and Description. For example, enter a descriptive
name for the role and describe how that role is used in the Description
field.

b. Set the database permissions for this role to be Full control (Administrator).
c. Select the Membership tab.
d. Click Add and select the domain user or group of users that you wish to

give access to the Case Analyzer OLAP database.
e. Click Add. If you want to add more than one user or group, you must add

them separately by repeating the previous 3 steps.
f. Click OK.
g. Click OK.

Configuring Excel Reports for Case Analyzer
If you installed the Excel Reports component, you must configure it to generate
reports from statistical information gathered from the Content Platform Engine or
Process Simulator.

Instead of storing the reports on each individual server, you can make them
available to remote workstations in different ways. You can share the drive where
the reports are located on the network. You can save the reports to a network drive
or save the reports to an object store. If you take one of these actions, you must:
v Verify that the prerequisite software is installed on the workstation of each user.

See “Install prerequisite software” on page 21.
v Point the users to the location of the reports.
v Point the users to the IBM FileNet Case Analyzer Installation and Upgrade Guide.

See the IBM FileNet P8 Help topic Integrating workflow into document
management > IBM FileNet Case Analyzer User Guide

To configure Excel Reports for Case Analyzer:
1. Log in as a ca_client_database_user.
2. Start the Case Analyzer Configuration Tool, go to Start > All Programs > IBM

FileNet P8 Platform > Case Analyzer components > Case Analyzer Client
Configuration Tool.

3. Enter the name of the Case Analyzer Analysis Server where the Case Analyzer
OLAP database is located.
Depending on whether the Content Platform Engine has a local or remote
OLAP database, your entry is the name of:
v the server where the Content Platform Engine Engine software was installed

or
v the remote OLAP database server used by the Content Platform Engine

Important: In highly available environments, use the virtual IP or name of the
SQL Server Analysis Services server.

4. Select the Database Version for Case Analyzer Analysis Services:
v Microsoft SQL Server 2008
v Microsoft SQL Server 2008 R2
v Microsoft SQL Server 2012
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5. Enter the Database Name for Case Analyzer Analysis Services or the OLAP
database name.

6. Enter the Analysis Services Instance Name.

Tip: This field requires a value only when installing on SQL Server with a
non-default Analysis Service. If you are installing on SQL Server with the
default instance, you can leave the field empty.

7. Verify that the folder where you store your reports is listed in the Root Report
Folder field. By default, the field contains the location where installation
installed the out-of-box reports. If your reports are stored in another folder,
enter the path to that folder here.

8. Click Configure. The Case Analyzer Client Configuration Tool configures the
out-of-box reports. It configures the data connection in all Excel spreadsheets in
all folders one level below the indicated folder. The progress of the
configuration displays in the Results box.

Tip: Following configuration, on the Case Analyzer components computer you
can view the sample reports or create new reports. For details, see the FileNet
P8 Help topic Integrating workflow into document management > Workflow
Analysis reports

9. Select File > Exit to close the Case Analyzer Client Configuration Tool.

Configure Cognos Business Intelligence project for Case
Analyzer

If you installed the Cognos Business Intelligence project component, you must
configure it to generate reports from statistical information gathered from the
Content Platform Engine or Process Simulator.

Perform the following procedures on the IBM Cognos Business Intelligence server
to configure Cognos Business Intelligence project to run IBM FileNet Case
Analyzer reports.

“Installing prerequisite software for IBM Cognos Business Intelligence” on page
27
You must install the required Microsoft SQL Server add on software to run IBM
Cognos Business Intelligence reports on Case Analyzer.
“Deploying Case Analyzer reports on IBM Cognos Business Intelligence” on
page 27
You must configure the IBM Cognos Business Intelligence server to deploy Case
Analyzer reports.
“Updating the DataSource connection” on page 27
By default, the Case Analyzer DataSource connection is configured for the
localhost Analysis server. If you are using another Analysis server, you can
update the DataSource connection to point to that Analysis server.
“Updating the OLAP database name” on page 28
By default, the Case_Analyzer_Reports package communicates with OLAP
databases named CAOLAPDB. You can update the Reports package to run your
reports on a different OLAP database.
“Viewing the reports” on page 28
After you create a Case_Analyzer_Reports package, you can view the reports
that are generated from that package.
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Installing prerequisite software for IBM Cognos Business
Intelligence
You must install the required Microsoft SQL Server add on software to run IBM
Cognos Business Intelligence reports on Case Analyzer.

The IBM FileNet Case Analyzer user workstations that run IBM Cognos Business
Intelligence reports must have the Microsoft Analysis Services 10.0 OLE DB
Provider for Microsoft SQL Server running on them. The appropriate package for
the version of the SQL Server must be installed.

Tip: This add-on is available for download from Microsoft. For details, see IBM
FileNet P8 Hardware and Software Requirements.

If the OLAP Microsoft SQL Server database is remote from the IBM Cognos
Business Intelligence server, the Microsoft SQL Server Client software must be
installed on the IBM Cognos Business Intelligence server.

You must also grant access rights to the Case Analyzer OLAP database. See
“Granting access rights to the Case Analyzer OLAP database” on page 24 for more
information.

Deploying Case Analyzer reports on IBM Cognos Business
Intelligence
You must configure the IBM Cognos Business Intelligence server to deploy Case
Analyzer reports.

To deploy IBM FileNet Case Analyzer reports on IBM Cognos Business
Intelligence:
1. Open the IBM Cognos Welcome page:

a. Start your Web browser.
b. In the address bar, type the URL supplied by your administrator and press

Enter. The URL looks like: http://<servername>/cognos8 where servername is
the name of your IBM Cognos Business Intelligence server.

2. Click Administer IBM Cognos Content.
3. Click the Configuration tab and select Content Administration.
4. Click New Import.
5. Select Case_Analyzer_Reports and click Next.
6. Accept the default name Case_Analyzer_Reports and click Next.
7. Check the Case_Analyzer_Reports and click Next.
8. Accept the default values at the following screens and click Finish.
9. In the Select when you want to run this import screen, click Run.

10. Check View the details of this import after closing this dialog and click OK.
11. Click Refresh to display the results of your imports.

Updating the DataSource connection
By default, the Case Analyzer DataSource connection is configured for the
localhost Analysis server. If you are using another Analysis server, you can update
the DataSource connection to point to that Analysis server.

To update the DataSource connection:
1. From IBM Cognos Administration, select the DataSource Connections link

and click Refresh to display a Case_Analyzer_DataSource.
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2. Click the link for Case_Analyzer_DataSource.
3. Check Case_Analyzer_DataSource and click More.
4. Click the Set Properties link.
5. Select the Connection tab.
6. Click on the edit pencil to update the connection string to point to the analysis

server.
7. Change the Server name property to the analysis server name and click OK.
8. Click OK.

Updating the OLAP database name
By default, the Case_Analyzer_Reports package communicates with OLAP
databases named CAOLAPDB. You can update the Reports package to run your
reports on a different OLAP database.

If your OLAP database is not named CAOLAPDB, you can configure the
Case_Analyzer_Reports package to use your database name and redeploy the
package.

Attention: If your OLAP database is named CAOLAPDB, you can skip these
steps.

To update and redeploy the Reports package:
1. Go to the Case_Analyzer_Project directory and open the Model.xml file.
2. Go to the <namespace = "en">Model</name> tag.
3. Rename all occurrences of CAOLAPDB to the name of your OLAP database

and press Enter.
4. Open an IBM Cognos 8 Framework Manager and select Open a project.
5. Open the Case_Analyzer_Project file (Case_Analyzer_Project.cpf).
6. Click on the Packages node and select Case_Analyzer_Reports.
7. Right click on Case_Analyzer_Reports and select Publish Packages.
8. Check Enable model versioning and Delete all previous model versions.
9. Click Publish at the last screen in the wizard.

10. At the Do you wish to publish this package prompt, click Yes.
11. Save the package and exit IBM Cognos 8 Framework Manager.

Viewing the reports
After you create a Case_Analyzer_Reports package, you can view the reports that
are generated from that package.

To view reports from the Case_Analyzer_Reports package:
1. Open the IBM Cognos Welcome page:

a. Start your Web browser.
b. In the address bar, type the URL supplied by your administrator and press

Enter. The URL looks something like: http://<servername>/cognos where
servername is the name of your IBM Cognos Business Intelligence server.

2. Click Administer Cognos.
3. Select Launch > Report Studio and click Content_Analyzer_Reports.
4. Click Open an existing report or template.
5. Select the folder from which you want to retrieve the report.
6. Select the wanted report and click Open.
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7. Click OK.
8. Click OK again.
9. From the top-level menu, select Run > Run Report - HTML.

Configure Case Monitor project for Case Analyzer
If you installed the Case Monitor project component, you must configure it to
integrate with IBM Cognos Real-time Monitoring to monitor the current state of
case and workflow processes.

Perform the general procedures that are described in the ../
com.ibm.p8.prmonitor.doc/gs_get_started.dita section of the Information Center to
ensure that the required applications are running and the pre-configured Case
Monitor objects are imported to your IBM Cognos Real-time Monitoring
installation.

If you plan to implement IBM Case Manager solutions, Case and Task objects are
provided for your use. You can continue to monitor workflows and work items
with the provided Workflow and Work Item objects.

Installing Case Analyzer software updates
Perform the procedure in this topic for each Case Analyzer instance to install
software updates such as a mod release, fix pack, or interim fix.

To install the IBM FileNet Case Analyzer software updates:
1. To obtain the latest Case Analyzer software updates, and to determine whether

additional interim fixes are needed, contact your service representative.
2. Open the readme files for the Case Analyzer software updates and perform the

installation procedures in the readme files on each Case Analyzer instance.
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Planning and preparing for upgrade

This section provides instructions for preparing your system to upgrade IBM
FileNet Case Analyzer, formerly known as Process Analyzer.

“Planning the upgrade”
This section provides upgrade details and links to help you prepare your
environment for the Case Analyzer upgrade. Review this information
thoroughly before you start to upgrade Case Analyzer or required vendor
software.
“Performing required preparation tasks” on page 32
You must complete all of the required preparation tasks before you start the
upgrade.

Planning the upgrade
This section provides upgrade details and links to help you prepare your
environment for the Case Analyzer upgrade. Review this information thoroughly
before you start to upgrade Case Analyzer or required vendor software.

The upgrades described in this guide assume that you retain your basic platform
configuration from the previous release and that you have already upgraded
FileNet P8 to 5.2.

If you need full access to all case and simulation data immediately after the
FileNet P8 upgrade, you can upgrade IBM FileNet Case Analyzer and IBM FileNet
Process Simulator at the same time . However, to accommodate system resources
and schedules, you can also upgrade these components at a later time, such as the
following weekend. All backlogged data is processed after those upgrades are
complete. See the IBM FileNet Process Simulator Installation and Upgrade Guide for
information on upgrading that component.

“Supported upgrade paths”
Before you upgrade Case Analyzer, you must determine which platforms are
supported and update your independent software vendor software to the
appropriate patch level.

Supported upgrade paths
Before you upgrade Case Analyzer, you must determine which platforms are
supported and update your independent software vendor software to the
appropriate patch level.

Determine the supported platforms for this IBM FileNet Case Analyzer upgrade
and update your software to the appropriate patch level.
v See the IBM FileNet P8 Hardware and Software Requirements document for the

version numbers of product platforms supported for use with IBM FileNet Case
Analyzer 5.2.

v Before you upgrade your FileNet software, update your independent software
vendor (ISV) software to the patch and Service Pack levels that FileNet supports.

© Copyright IBM Corp. 2001, 2013 31

|
|
|

|
|
|
|
|
|
|



Performing required preparation tasks
You must complete all of the required preparation tasks before you start the
upgrade.

Attention: In addition to the following preparation tasks listed, follow the
instructions in Plan and Prepare Your Environment for IBM FileNet P8 for the
components you are installing.

To prepare your environment for an IBM FileNet Case Analyzer installation:
v Perform the required preparation tasks for the components you plan to install.
v Use the Installation and Upgrade Worksheet for your environment. All

administrators must fill out the worksheet with the relevant information as
described in “Using the installation and upgrade worksheet” on page 3.
“Installation administrator tasks”
The Installation administrator must prepare for the Case Analyzer upgrade by
verifying the supporting software and the core platform support levels.
“IT administrator tasks” on page 33
The IT administrator must prepare the system for the Case Analyzer upgrade
by backing up the existing Case Analyzer Engine and disabling any scheduled
tasks on the Case Analyzer server.
“Security administrator tasks” on page 34
IBM FileNet Case Analyzer upgrades do not require any actions by the Security
administrator.
“Database administrator tasks” on page 34
The Database administrator must prepare the databases that are required for
Case Analyzer by gathering pertinent database information and enabling XA
transactions for Microsoft SQL Server or Oracle.
“IBM FileNet P8 administrator upgrade tasks” on page 35
The FileNet P8 administrator must carry out several tasks to prepare your
environment for your IBM FileNet Case Analyzer upgrade.

Installation administrator tasks
The Installation administrator must prepare for the Case Analyzer upgrade by
verifying the supporting software and the core platform support levels.

The following topic describes how to verify and upgrade core platform software
for an IBM FileNet Case Analyzer upgrade.

“Verifying the core platform components support levels”
Before you start the Case Analyzer upgrade, verify and upgrade the core
platform support levels that are described in this topic.

Verifying the core platform components support levels
Before you start the Case Analyzer upgrade, verify and upgrade the core platform
support levels that are described in this topic.

The core platform support levels for a IBM FileNet Case Analyzer upgrade are:
v You must upgrade and configure the core platform components, IBM FileNet

Content Engine, IBM FileNet Process Engine, and IBM FileNet Application
Engine before starting the Case Analyzer upgrade.
For more information, see IBM FileNet P8 Hardware and Software Requirements.

v You must upgrade Case Analyzer before you upgrade Process Simulator.
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v You can upgrade to Case Analyzer 5.2 from Case Analyzer (formerly known as
Process Analyzer) versions 4.5.0, 4.5.1, and 5.0.

Important: Apply the required minimum level of Case Analyzer patches to the
currently installed software before you upgrade. FileNet P8 patches and fix packs
often include feature updates that are required to ensure a successful upgrade.
Therefore, before you begin your upgrade to Case Analyzer 5.2, you must have
applied the minimum level of fix packs to your installed 4.x and 5.0 components.
For more details, see IBM FileNet P8 Hardware and Software Requirements.

IT administrator tasks
The IT administrator must prepare the system for the Case Analyzer upgrade by
backing up the existing Case Analyzer Engine and disabling any scheduled tasks
on the Case Analyzer server.

The Information Technology administrator must perform the following tasks.
“Ensuring minimum required disk space and temp space for installation”
Your system must meet the disk space and temp space requirements for a Case
Analyzer upgrade.
“Backing up the Case Analyzer Engine”
Make sure that the site has restorable backups of the system and data for all
IBM FileNet Case Analyzer and IBM FileNet Process Engine components. In an
emergency, you might have to back out of the upgrade.
“Disabling scheduled tasks on the Case Analyzer server” on page 34
Before you start the upgrade, you must disable some of the tasks that are
scheduled to run on the Case Analyzer server.

Ensuring minimum required disk space and temp space for
installation
Your system must meet the disk space and temp space requirements for a Case
Analyzer upgrade.

To ensure that your system has the required disk space and temp space for an IBM
FileNet Case Analyzer installation, see the Case Analyzer requirements section in
IBM FileNet P8 Hardware and Software Requirements.

Backing up the Case Analyzer Engine
Make sure that the site has restorable backups of the system and data for all IBM
FileNet Case Analyzer and IBM FileNet Process Engine components. In an
emergency, you might have to back out of the upgrade.

For details on what to back up for FileNet P8 components, see the IBM FileNet P8
Help topic Administering IBM FileNet P8 > Backing up and restoring IBM
FileNet P8 components.

Back up the following items:
v The database used by Process Engine to which this Case Analyzer Engine is

connected.
v The Case Analyzer SQL database.
v The analyzer.properties file. Default location: C:\Program Files\Filenet\

Process Analyzer Engine\jpa.
v The Analysis Server OLAP database. Make a note of any special configuration

that has been applied to cubes or dimensions, such as role assignments or
auto-grouping. The configuration must be reapplied after the upgrade is
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complete. See the Analysis Manager online help for more information and
detailed instructions on creating roles and assigning users.

Disabling scheduled tasks on the Case Analyzer server
Before you start the upgrade, you must disable some of the tasks that are
scheduled to run on the Case Analyzer server.

Disable the following scheduled tasks on theIBM FileNet Case Analyzer server:
1. Scheduled automated backups
2. Virus scanning

Security administrator tasks
IBM FileNet Case Analyzer upgrades do not require any actions by the Security
administrator.

Database administrator tasks
The Database administrator must prepare the databases that are required for Case
Analyzer by gathering pertinent database information and enabling XA
transactions for Microsoft SQL Server or Oracle.

The Database administrator must complete the following tasks.
“Verifying that the Oracle listener is running”
If your IBM FileNet Process Engine uses an Oracle database, verify that the
Oracle listener is running on the Process Engine database server.
“Gathering database information”
Before you can upgrade Case Analyzer, you must gather the database
information that is required for the upgrade.
“Enabling Microsoft SQL Server XA transactions” on page 35
Configure the Windows server to enable Microsoft SQL Server XA transactions.
“Configuring Oracle XA transactions” on page 35
Configure Oracle XA transactions for Case Analyzer by running several Oracle
SQL scripts.

Verifying that the Oracle listener is running
If your IBM FileNet Process Engine uses an Oracle database, verify that the Oracle
listener is running on the Process Engine database server.

This requirement is only intended for Oracle databases.

Gathering database information
Before you can upgrade Case Analyzer, you must gather the database information
that is required for the upgrade.

You need the following database information for the IBM FileNet Case Analyzer
upgrade:
v Your current Database Instance Names, NLS, and character set configurations
v The dedicated TCP/IP port number of the database instance that Case Analyzer

uses

To determine the TCP/IP port number for Microsoft SQL Server:
1. Open Microsoft SQL Server Enterprise Manager and display the database

instance properties.
2. On the General tab, click Network Configuration.
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3. Select TCP/IP in Enabled protocols.
4. Click Properties.

Enabling Microsoft SQL Server XA transactions
Configure the Windows server to enable Microsoft SQL Server XA transactions.

Perform these steps on every Microsoft SQL Server that will contain anIBM FileNet
Case Analyzer database.

To enable Microsoft SQL Server XA transactions:
1. From Control Panel, open Administrative Tools, and then open Component

Services.
2. Expand Component Services, right-click My Computer, and then select

Properties.
3. Expand Distributed Transaction Coordinator and right-click Local DTC.
4. Click the MSDTC tab, and then click Security Configuration.
5. Select the Enable XA Transactions check box, and then click OK to restart the

Microsoft DTC service.
6. Click OK again to close the Properties dialog box, and then close Component

Services.
7. Stop and then restart the Microsoft SQL Server.

Configuring Oracle XA transactions
Configure Oracle XA transactions for Case Analyzer by running several Oracle
SQL scripts.

To configure Oracle XA transactions:
1. Log on the Oracle database as either SYSOPER or SYSDBA.
2. Locate and run the initxa.sql script in the ORACLE_HOME\javavm\install

directory.
3. If the script fails to run because the database memory space is too small, locate

and run the initjvm.sql script in the ORACLE_HOME\javavm\install directory.
Additional memory-related parameters might need to be adjusted to
successfully run this script.

IBM FileNet P8 administrator upgrade tasks
The FileNet P8 administrator must carry out several tasks to prepare your
environment for your IBM FileNet Case Analyzer upgrade.

Review all rows assigned to the FileNet P8 Administrator (P8A) in the Installation
and Upgrade Worksheet. While you complete the following preparation tasks,
provide values for the rows that are appropriate to your installation.

Tip: With the Data > Filter > AutoFilter command enabled, as it is by default in
the shipping worksheet file (p8_worksheet.xls), perform the following actions to
quickly see only the properties assigned to a particular role:
v Click the AutoFilter drop-down arrow in the Role column header and select

P8A.
v Further filter the result set by clicking the AutoFilter drop-down arrow in any

of the other columns and selecting a value or clear a filter by selecting All.
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“Collecting settings for caupgrade wizard”
Collect the values for all settings in the caupgrade wizard. These values are
needed for all Case Analyzer upgrades.

Collecting settings for caupgrade wizard
Collect the values for all settings in the caupgrade wizard. These values are needed
for all Case Analyzer upgrades.

During the upgrade of IBM FileNet Case Analyzer, you will run caupgrade. After
providing information to the caupgrade program, you run the program to upgrade
the Case Analyzer database. You can provide the values to caupgrade in a wizard
or in a property file that is an input file to the caupgrade program. The
information you must gather varies depending on whether you are upgrading
from Version 5.1.0, 5.0, 4.5.0 or 4.5.1.

The following table shows the information that is required and where to collect it
on the source Case Analyzer system. Several values are not on the source system
but are needed for the upgrade. For each property name, record the value in your
Installation and Upgrade Worksheet. Property names in this table reflect the name
in the caupgrade wizard user interface.

Property name Description Comments

Case Analyzer database Case Analyzer database
configuration information.

N/A

v Repository name A unique name that you
assign to the Case Analyzer
Store. For example, you can
use CAStore.

Do not use the Case Analyzer
database name.

v Object Store When you select Object
Store as the event source, the
name of the object store from
which to retrieve data.

Select the object store that
you created for the Case
Analyzer upgrade.

v Event Source: Legacy
Workflow System

When you select Legacy
Workflow System as the
event source, the name of the
legacy workflow system from
which to retrieve data.

Select the legacy workflow
system for which you created
a connection point for the
Case Analyzer upgrade.

Case Analyzer connection
information

Case Analyzer schema and
connection configuration
information.

N/A

v Database schema name The name of the Case
Analyzer database schema in
the database that is specified
in the Repository name field.

Default is dbo for most
installations

v Database connection name
(use existing connection)

The existing connection name
from the drop down menu.

N/A

v Database connection name
(define a new connection)

The name assigned to the
connection between the Case
Analyzer database and
Content Platform Engine.

N/A
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Property name Description Comments

v Database source name If the Case Analyzer database
is shared with an object store,
the data source name of the
object store.

The name you enter in the
Case Analyzer Repository
Upgrade Wizard must match
the data source name that
you defined in Configuration
Manager (CMUI).

v XA data source name If the Case Analyzer database
is shared with an object store,
the XA data source name of
the object store.

The name you enter in the
Case Analyzer Repository
Upgrade Wizard must match
the data source name that
you defined in Configuration
Manager (CMUI).

Case Analyzer OLAP
database

Case Analyzer OLAP
integration configuration
information.

N/A

v Database host The host name of the Case
Analyzer database server.

Based on the version from
which you are upgrading.

Process Task Manager - Case
Analyzer or Process Analyzer
database tab

v Database instance The instance of the Case
Analyzer database.

v Database name The name of the Case
Analyzer OLAP database.

Based on the version from
which you are upgrading.

Process Task Manager - Case
Analyzer or Process Analyzer
database tab

v Database user name The Windows name of the
user who has permission to
connect to the Case Analyzer
OLAP database.

You can use the
ca_administrator user that was
configured for the Case
Analyzer Windows service.

v Database user password The password for the Case
Analyzer OLAP database
user name.

N/A

v Database user domain The domain for the Case
Analyzer OLAP database
user.

N/A

v Connector host The host name of the Case
Analyzer SSAS Connector
server.

N/A

v Connector port The port number that is used
by the Case Analyzer SSAS
Connector server.

Default value is 32771
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Property name Description Comments

Case Analyzer
analyzer.properties file

For a Case Analyzer 5.x
upgrade, navigate to
C:\Program Files
(x86)\IBM\FileNet\Case
Analyzer Engine\jpa

For a Process Analyzer 4.5.x
upgrade, navigate to
C:\Program Files
(x86)\IBM\FileNet\Process
Analyzer Engine\jpa

Copy the
analyzer.properties file to a
location that can be accessed
by the caupgrade wizard.
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Upgrade and configure Case Analyzer

In the 5.2 release, the Case Analyzer Engine is installed as part of Content Platform
Engine. To upgrade Case Analyzer, you must create data spaces for the database
connections and update the Case Analyzer databases.

Complete the following tasks to upgrade IBM FileNet Case Analyzer from 4.5.0,
4.5.1, or 5.0.0 to version 5.2:
v Upgrade the IBM FileNet P8 platform to version 5.2
v Open Process Task Manager and collect information that you need to update the

Case Analyzer databases. For more information, see “Collecting settings for
caupgrade wizard” on page 36.

v Uninstall or disable the Case Analyzer Engine
v Go to C:\Program Files (x86)\IBM\FileNet\Case Analyzer\jpa or C:\Program

Files (x86)\IBM\FileNet\Process Analyzer\jpa and copy the
analyzer.properties file to a location that can be accessed by the caupgrade
wizard

v Create the data sources for the connections to the database
v Run the IBM Case Foundation installation program to install and configure the

SSAS OLAP Connector
v Launch the caupgrade wizard and update the databases
v Set the Analysis Exporter Enable flag on the domain to true in the

Administration Console for Content Platform Engine and restart the application
server

v Process the OLAP cubes using the Process Task Manager or schedule the
processing of cubes in the Administration Console for Content Platform Engine
“Uninstalling or disabling Case Analyzer Engine”
You must either uninstall or disable the existing Case Analyzer Engine before
you can upgrade Case Analyzer.
“Creating data sources for Case Analyzer databases” on page 40
You must create JDBC data sources for each database that Case Analyzer uses.
Content Platform Engine and the caupgrade tool use this data source
information to connect to and update the database.
“Creating the Case Analyzer upgrade property file and upgrading the
database” on page 41
You can create the Case Analyzer upgrade property file and upgrade the
database interactively or manually.
“Installing Case Analyzer software updates” on page 43
Perform the procedure in this topic for each Case Analyzer instance to install
software updates (mod release, fix pack, or interim fix).

Uninstalling or disabling Case Analyzer Engine
You must either uninstall or disable the existing Case Analyzer Engine before you
can upgrade Case Analyzer.

For software requirements for the IBM FileNet Case Analyzer components and
other tools such as MS Excel, see the IBM FileNet P8 Hardware and Software
Requirements document.
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To uninstall or disable the Case Analyzer Engine:
1. Uninstall Case Analyzer Engine.

a. On the Case Analyzer Engine server, go to Start > Settings > Control Panel
and then double-click Add/Remove Programs.

b. Select FileNet Case Analyzer Engine from the list of installed programs
and click Change/Remove.

c. Click Yes to confirm you want to remove the existing Case Analyzer Engine.
d. Click OK when the Uninstallation program is finished.
e. Close the Add/Remove Programs snap-in.
f. Close the Control Panel.

2. Disable Case Analyzer Engine:
a. Stop the Case Analyzer Services Manager.
b. Access the properties for the Case Analyzer server in the administration

console.
c. In the Status field, select Disabled.
d. Save your changes.

Creating data sources for Case Analyzer databases
You must create JDBC data sources for each database that Case Analyzer uses.
Content Platform Engine and the caupgrade tool use this data source information
to connect to and update the database.

Be sure that you have available the Installation and Upgrade Worksheet that was
completed during your planning activities.

To configure the JDBC settings for Case Analyzer databases:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data > Filter > AutoFilter command
is enabled. To view only Content Platform Engine values, filter by
CM:Configure Case Analyzer JDBC Data Sources (database 1) in the
Installation or Configuration Program column.

2. If your configuration profile is not open in Configuration Manager, open it by
selecting File > Open and navigating to your profilename.cfgp file.

3. Create a task for the Case Analyzer JDBC data source.

Tip: If the Case Analyzer database data sources you are creating share
common information such as database server and port, you can copy an
existing Configure Object Store JDBC Data Sources task and edit it instead of
entering the information again.
a. Right-click any task name in the profile pane, such as Configure Object

Store JDBC Data Sources, and select Add New Task > Configure JDBC
Data Sources. The New_Configure JDBC Data Sources task is added to
the profile.

b. Right-click New_Configure JDBC Data Sources, and select Rename Task.
c. Enter a useful name for the task, such as Configure Case Analyzer

database 2 JDBC Data Sources.
d. Click OK.

4. Right-click the Configure Case Analyzer database 2 JDBC Data Sources task
in the profile pane, and select Edit Selected Task.
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5. Enter the property values for the JDBC data sources for the database by using
the values in your worksheet.

6. Select File > Save to save your changes.
7. Optional: WebSphere® and WebLogic only. Click Test Database Connection to

test the connection to the database by using the database user name, database
server name, database name, port number, and password that you provided.
The test does not create the data sources.

8. Ensure that the task is enabled. When the task is disabled, the task name
includes the text (disabled). To enable the task, right-click Configure Case
Analyzer 2 JDBC Data Sources (disabled) in the profile pane, and choose
Enable Selected Task from the context menu.

9. Apply the JDBC property settings by right-clicking Configure database 2
JDBC Data Sources in the profile pane, and selecting Run Task. Running the
configuration task can take a few minutes. The task execution status messages
are displayed in the Console pane below the bootstrap properties.

10. (JBoss only) Start the application server instance.
11. Repeat this procedure to add the data sources for each Case Analyzer database

in your environment.

Creating the Case Analyzer upgrade property file and upgrading the
database

You can create the Case Analyzer upgrade property file and upgrade the database
interactively or manually.

You can create the upgrade property files interactively by using the caupgrade
wizard. When you complete the wizard, review your values and exit the wizard.
The upgrade starts automatically.

The alternative is to create the upgrade property file by manually editing the file
and manually starting the upgrade. For upgrades from IBM FileNet Case Analyzer
version 5.0, create a property file and run the upgrade once for each Case Analyzer
database. You can run multiple copies of caupgrade simultaneously.

“Creating the Case Analyzer upgrade properties file and starting the upgrade
with the GUI”
Start the caupgrade wizard and set upgrade configuration parameters for an
upgrade. After providing input to the wizard screen, you finish the wizard and
start the upgrade.
“Creating the Case Analyzer upgrade properties file manually and running the
upgrade” on page 43
You edit the caupgrade property file to provide Case Analyzer upgrade
parameters. You then run the caupgrade tool, specifying the
caupgrade.properties file as input to upgrade the Case Analyzer.

Creating the Case Analyzer upgrade properties file and
starting the upgrade with the GUI

Start the caupgrade wizard and set upgrade configuration parameters for an
upgrade. After providing input to the wizard screen, you finish the wizard and
start the upgrade.

Use the procedures in this task to run the caupgrade wizard to configure upgrade
parameters for an upgrade of IBM FileNet Case Analyzer. For upgrades from
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Process Analyzer versions 4.5.0, 4.5.1, and Case Analyzer version 5.0, complete
these procedures for every Case Analyzer database on your system.

To configure the upgrade parameters for a Case Analyzer upgrade:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data > Filter > AutoFilter command
is enabled. To view only caupgrade values, filter by caupgrade in the
Installation or Configuration Program column.

2. Log on to the Content Platform Engine server or a remote workstation as
ca_upgrade_user.

3. At a command prompt, type C:\Program Files (x86)\IBM\FileNet\
ContentEngine\tools\PE\caupgrade.bat -A analyzer.properties to start
caupgrade.

-E OLAP database password
An independent option that generates an encrypted password to enter
into the silent property file.

-A analyzer.properties
The analyzer.properties file contains raw data that is copied from an
existing Case Analyzer prior to the upgrade. This data is not modified
by the user.

-O output file name
The name of the file to which output information is written.

-I CA Repository.properties
The upgrade.properties file is optional for the GUI upgrade, but you
can specify it if you want to collect this information before you run the
upgrade.

-Yca_upgrade_user+password
The Windows name and password of a user with permission to connect
to the Case Analyzer SSAS Connector.

-s Including this parameter in the command line indicates that caupgrade
should run in silent mode. If this parameter is used, an input file must
be provided. Input values are read from the input file and no user
interface is presented to the user.

4. Using the values from your Installation and Upgrade Worksheet file, complete
the wizard screens.

5. Review the summary screen and make any changes if necessary.
6. Click Finish to save the information to the output file, caupgrade.properties,

and to start the upgrade.

Case Analyzer services must be enabled in order for the upgraded Case Analyzer
store to process new events. The Case Analyzer service is not enabled by default.
To enable Case Analyzer services in Content Platform Engine, do the following
steps:
1. Open IBM Administration Console for Content Platform Engine and select the

level at which you want to enable Case Analyzer services.
2. Click the Workflow Subsystem tab.
3. Select the Case Analyzer enabled option and click OK.
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Creating the Case Analyzer upgrade properties file manually
and running the upgrade

You edit the caupgrade property file to provide Case Analyzer upgrade parameters.
You then run the caupgrade tool, specifying the caupgrade.properties file as input
to upgrade the Case Analyzer.

To create the Case Analyzer upgrade properties file and run the upgrade:
1. Open your completed Installation and Upgrade Worksheet file.

Tip: In the worksheet file, verify that the Data > Filter > AutoFilter command
is enabled. To view only caupgrade values, filter by caupgrade in the
Installation or Configuration Program column.

2. Log on to the Content Platform Engine server or a remote workstation.
3. Copy the caupgrade.properties.sample file to caupgrade.properties and edit

the caupgrade.properties file using the values from the worksheet.
a. Change the current directory to cpe_install_path\tools\PE\samples where

cpe_install_path is the location of the program files.
b. Using a text editor, edit the caupgrade.properties file by providing the

parameter values for your configuration.
c. Enter the parameters, one parameter per line in the following format:

parameter name=value

4. At a command prompt, type C:\Program Files (x86)\IBM\FileNet\
ContentEngine\tools\PE\caupgrade -I C:\Program Files (x86)\IBM\FileNet\
ContentEngine\tools\PE\samples\caupgrade_CA_Repository.properties -A
cpe_install_directory\data\analyzer.properties -Y
ca_upgrade_user+password.

-s (optional) Including this parameter in the command line indicates that
caupgrade should run in silent mode. If this parameter is used, an
input file must be provided. Input values are read from the input file
and no user interface is presented to the user.

Case Analyzer services must be enabled in order for the upgraded Case Analyzer
store to process new events. The Case Analyzer service is not enabled by default.
To enable Case Analyzer services in Content Platform Engine, do the following
steps:
1. Open IBM Administration Console for Content Platform Engine and select the

level at which you want to enable Case Analyzer services.
2. Click the Workflow Subsystem tab.
3. Select the Case Analyzer enabled option and click OK.

Installing Case Analyzer software updates
Perform the procedure in this topic for each Case Analyzer instance to install
software updates (mod release, fix pack, or interim fix).

To install the IBM FileNet Case Analyzer software updates:
1. To obtain the latest Case Analyzer software updates, and to determine whether

additional interim fixes are needed, contact your service representative.
2. Open the readme files for the Case Analyzer software updates and perform the

installation procedures in the readme files on each Case Analyzer instance.
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“Updating Case Monitor workbench objects”
When you upgrade FileNet Case Analyzer to the IBM FileNet P8 Release 5.2
and you used the Case Monitor workbench objects in the prior release, then
you must update your Case Monitor projects files.

Updating Case Monitor workbench objects
When you upgrade FileNet Case Analyzer to the IBM FileNet P8 Release 5.2 and
you used the Case Monitor workbench objects in the prior release, then you must
update your Case Monitor projects files.

To reuse the workbench objects that monitor active cases, tasks, work items, and
workflows with the current release of Case Analyzer, you must update the objects
with the replacement views.

In the workbench objects, update the views by changing the following line of code.

Table 3. Case Monitor workbench objects that require updating with current views

Workbench object Replace... With...

Case Data Stream from F_DMCaseWIP from V_F_DMCaseWIP

Task Data Stream from F_DMTaskWIP from V_F_DMTaskWIP

Work Item Data Stream from F_DMWIP from V_F_DMWIP

Workflow Data Stream from F_DMWorkflowWIP from V_F_DMWorkflowWIP

Number of Work Items Per
Bucket Data Stream

from F_DMWIP from V_F_DMWIP

Number of Workflows Per
Bucket Data Stream

from F_DMWorkflowWIP from V_F_DMWorkflowWIP

Work Item Total Processing
Time Threshold Data Stream

from F_DMWIP from V_F_DMWIP

Workflow Processing Time
Threshold Data Stream

from F_DMWorkflowWIP from V_F_DMWorkflowWIP

For example, in the following workbench object from the IBM FileNet P8 Release
5.0 of Case Monitor, edit the Task Data Stream object file and replace F_DMTaskWIP
with V_F_DMTaskWIP. The corrected object retrieves the appropriate data for your
query.

Task Data Stream
select DMTaskType_key,

DMUser_key,
DMTaskState_key,
Count(*) as TaskCount,
avg(WaitCurrentMinutes+MinutesSinceLastEvent*IsInWaitStatus) avgWaitTime ,
avg(ProcCurrentMinutes+MinutesSinceLastEvent*IsInProcStatus) as avgProcTime ,
avg(ReadyCurrentMinutes+MinutesSinceLastEvent*IsInReadyStatus) as avgReadyTime ,
avg(FailCurrentMinutes+MinutesSinceLastEvent*IsInFailStatus) as avgFailedTime

from F_DMTaskWIP
group by DMTaskType_key, DMUser_key, DMTaskState_key
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Removing Case Analyzer components

You can remove all or selected Case Analyzer components from your Case
Analyzer computer.

You cannot remove the IBM FileNet Case Analyzer components separately in silent
mode. Running the silent uninstallation program removes all of the Case Analyzer
components that are installed on your system.

Perform the following tasks on your Case Analyzer computer for the type of
software removal you want to run.

“Removing Case Analyzer components interactively”
Use the Windows Control Panel to remove some or all of the Case Analyzer
components interactively.
“Removing Case Analyzer components silently”
You can run a command to silently remove all of the installed Case Analyzer
components.

Removing Case Analyzer components interactively
Use the Windows Control Panel to remove some or all of the Case Analyzer
components interactively.

To remove IBM FileNet Case Analyzer components interactively:
1. On the computer where Case Analyzer components are installed, select Control

Panel > Add/Remove Programs. On Windows 7, select Programs and Features.
2. Select IBM Case Foundation and click Change/Remove to launch the Uninstall

IBM Case Foundation program. On Windows 7, click Uninstall/Change.
3. In the Uninstall Options screen, choose to uninstall some or all of the Case

Analyzer components.
4. In the Choose Components screen, select which Case Analyzer components to

remove.
5. In the Uninstall Complete screen, note the directories and files that cannot be

removed by the uninstall program and choose whether to have the program
restart the computer or restart it manually.

6. Remove the remaining directories and files, as noted in the Uninstall Complete
screen.

7. If you want to completely removed all traces of the IBM Case Foundation
installation, delete the C:\Program Files (x86)\IBM\FileNet\CaseFoundation
directory.

Removing Case Analyzer components silently
You can run a command to silently remove all of the installed Case Analyzer
components.

To remove IBM FileNet Case Analyzer components silently:
1. Run the following command:

CaseFoundation_install_path\IBM\FileNet\CaseFoundation\_cfuninst\
cf_uninstaller.exe -i silent
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2. When the uninstallation is complete, check the following log file to verify that
the uninstallation was successful.
C:\USER_TEMP\CaseFoundation_Uninstalllog
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample

48 IBM FileNet Case Analyzer Installation and Upgrade Guide



programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: © (your company name) (year). Portions of
this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
2004, 2010. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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